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The Bug 
On Windows 1o, the Sitka font family can be exported to a PDF from Office 
Home and Student 2021, but on Windows 11, it cannot. The problem is in the 
repackaging of the font family (from version 1.12 in Windows 101 to 2.00 in 
Windows 112). On either operating system, the Sitka fonts work as expected 
inside Office, for editing and printing. It’s only when publishing to a PDF, for 
posting to a website or a book publisher, that the bug arises. If a font will not 
export, the resulting PDF will likely be unacceptable for publication. The new 
packaging improves efficiency and semi-bold is included, along with the bug.3 

 
1 https://learn.microsoft.com/en-us/typography/fonts/windows_10_font_list. 
2 https://learn.microsoft.com/en-us/typography/fonts/windows_11_font_list. 
3 https://learn.microsoft.com/en-us/answers/questions/5159631/windows-11-disables-export-of-sitka-fonts, 

posted by the author in April 2022, but apparently ignored by Microsoft. See also 

https://github.com/MicrosoftDocs/typography-issues/issues/1160. 

mailto:pete.3nt@gmail.com?subject=Windows%2011%20Font%20Bug%20Circumvention%20(Aktis)
https://3nt.xyz/
https://learn.microsoft.com/en-us/typography/fonts/windows_10_font_list
https://learn.microsoft.com/en-us/typography/fonts/windows_11_font_list
https://learn.microsoft.com/en-us/answers/questions/5159631/windows-11-disables-export-of-sitka-fonts
https://github.com/MicrosoftDocs/typography-issues/issues/1160
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Choices of Circumvention 
Because Windows 10 is losing security support, it’s important to upgrade soon 
to Windows 11. We need to resolve the Sitka issue now.  

Replace Sitka 2.00 with Sitka 1.12 [nope, fails]. Unfortunately, the Windows 
11 Sitka fonts cannot be superseded. Attempts to replace them with Sitka from 
Windows 10 were unsuccessful. [Downgrading Windows 11 to 10 worked well.]  

Print to a Third-Party PDF Driver [maybe works]. The new restrictions in 
Sitka 2.00 are enforced by Microsoft’s Print to PDF driver, which is accessed via 
File-Export or when selected as the printer via File-Print. Selecting a third-party 
driver may bypass this check. [I use CutePDF Writer with some old apps. If this 
does work, it will probably store the PDF into the most recent folder used by the 
driver, not necessarily where the document is stored – a nuisance.] 

Upgrade Software [probably works]. Sitka 2.00 may have been intentionally 
disabled for export from Office Home & Student (or Windows Home). [If so, 
that’s morally corrupt. I won’t pay Microsoft for ripping the rug out from under 
me, and ignoring my complaints for several years.] 

Second System. Use a second system, either physical or virtual, to run Office 
and Windows 10 – without Internet access. VMware Workstation is now free for 
personal use. Running a Windows VM under Windows probably requires 
additional licenses. If Linux appeals, you could install it and run a VM of your 
current Windows 10 system. [I supported my in-house customers doing that for 
over a decade.] Most of the work will be on Linux and configuring VMware. 
That VM will be stuck on Windows 10 as long as we need Sitka.  

Change Software. Google Docs, OpenOffice, and LibreOffice are out there. [I 
tried and abandoned Libre Office years ago – Word H&S 2010 was better at 
some things that I do routinely. Google Docs has come on strong.] 

Change Fonts. Obtain a font that is suitable for your needs from a font foundry 
or from one of the free apps (check the licensing). Copy it to \Source (or such) 
to preserve it, and install it. You will own the solution. To avoid the current 
problem in the future, and for portability to a non-Microsoft environment, do 
not pick a Microsoft font. Test export to a PDF immediately for candidate fonts! 

Rename Sitka 1.12 – This Article. Make a copy of the Sitka font family, rename 
it (I chose Aktis, Sitka spelled backwards), and install it onto the system. Then 
change fonts to the new font. This article describes this plan in detail. 

Microsoft sold me the Sitka font family for use with Windows 10, and it worked 
beautifully. If I was not supposed to use it to publish my books and articles as 
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PDFs, they should have enforced that when they released Sitka in Windows 8.1, 
and included it in Windows 10. I would have picked another font. 

My site, 3NT.XYZ, is not for profit. Normally, I would post my Aktis-.ttc files and 
make them available for free. That’s clearly not legal. If you own Windows 10, 
then it’s entirely fair to create and modify your own copy of Sitka 1.12 for your 
own personal use. However, it is inappropriate either to share the fonts or to 
use the fonts to create documents in a non-Microsoft environment. 

[I’m not an attorney, and this is not legal advice.] 

The Sitka Font Family 
Matthew Carter designed the Sitka font family for readability on screen; its 
development was informed by active testing.4 The fonts have serifs, so they are 
also quite readable in print – definitely superior to Calibri, the default font in 
Microsoft Word at the time. This article uses Sitka Heading, which I chose in 
2021 as “my font,” first for headings (replacing the disappointing Cambria font) 
and then for most other text (replacing the sans serif Calibri font).  

Sitka Heading has served me well for This Singing World (a poetry anthology), 
two editions and counting of EZ-Expert Bidding Tools (a bridge book), and 
numerous articles. Highly readable in text, Sitka’s digits, with their varying 
heights and widths, do leave something to be desired for numerical applications 
such as spreadsheets: 

 0123456789 

A key to my decision is what I call the footprint of Sitka Heading: the amount of 
text or a specific character that can be crammed into a given space. My goal was 
to maximize the font size while keeping the footprint within that of Calibri in 

both height and width, making the conversion from Calibri easy. 

The emphasis on predictable footprint supports my semi-typeset printing plan. 
That’s different from the Sitka font family design, where Sitka Small has the 
largest relative footprint to maximize readability, decreasing the footprint 
through increasing application size of the Text, Subheading, Heading and 
Display fonts, until Sitka Banner has the smallest relative footprint.  

At the end of this article is the chart that I used to understand the footprints of 
the Sitka font family, as well as the Times New Roman and Calibri fonts.  

 
4 https://www.microsoft.com/en-us/research/wp-content/uploads/2021/06/Larson-Carter-2015-Sitka.pdf 

https://www.microsoft.com/en-us/research/wp-content/uploads/2021/06/Larson-Carter-2015-Sitka.pdf
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Analysis.5 After building chart in another file, I printed it directly from Word 
and measured it. W was the width of “The quick brown fox jumps over the lazy 
dog.” And H was the height of the current row/box, line to line. They cheated!  

All six Sitka fonts have the same line height, but the character sizes on the line 
differ. The characters intended for small use are bigger – of course they are 
easier to read, with nothing above or below them. However, paragraphs contain 
multiple lines. Sitka Small has the least white space between lines, while Sitka 
Banner has the most. White space definitely makes a difference in 
comprehension. There may be minor tweaks to different fonts, but this size 

difference is fundamental. Just because the design says Sitka Text is best for 11 
point text does not make it so. The testers were not presented paragraphs, but 
individual characters, either alone or with other characters left and right.  

My choice is Sitka Heading for most applications; at 11 point, it has the closest 
[smaller] footprint to 11.5 pt Calibri or Times New Roman. Sitka Subheading 
would take more space (width), and Sitka Display would take less space – either 
could be appropriate. The Sitka font family lets us pick our own footprint. I did 
use Sitka Text for the Index in Bidding Tools, where its larger relative footprint 
helps. For articles, such as this one, I prefer 14 point Sitka Heading. 

Alternative text fonts. Of all the other Serif fonts on my computer, only 
Georgia made my short list – you are reading it – I find it too tall. 

Details of the Circumvention 
Summary: Make copies of the Windows 10 Sitka fonts (version 1.12) with new 
names on Windows 10.6 Test the fonts on Windows 10. When satisfied, back up 
the font, upgrade to Windows 11, and test again. (If the upgrade damaged the 

renamed font, restore/install it from backup.)  

We won’t get the improved efficiency of Microsoft’s repackaging of the Sitka 
fonts for Windows 11. All use of Sitka fonts in a document must be changed to 
the new names, before exporting the document to a PDF on Windows 11. 

Capture All Fonts on Windows 10 
1. Make a “Windows 10 Fonts” folder, perhaps under \Source. 
2. Search > Control Panel > Fonts 

 
5 Excerpt from https://3nt.xyz/about/Publication_Notes.pdf, which also includes a brief comparison of fonts for 

back matter. Normal text in EZ-Expert Bidding Tools is 11.5-pt Sitka Heading; References are 10-pt Sitka 

Heading, and the Index is a highly readable 9-pt Sitka Text. 
6 A few versions of individual Sitka fonts are available at https://www.dafontfree.io/sitka-font/,  

https://fontsinuse.com/typefaces/38628/sitka, and https://www.onlinewebfonts.com/fonts/sitka. There are not 

enough fonts to provide regular, bold, italic, and bold-italic for just one size (such as Heading). 

https://3nt.xyz/about/Publication_Notes.pdf
https://www.dafontfree.io/sitka-font/
https://fontsinuse.com/typefaces/38628/sitka
https://www.onlinewebfonts.com/fonts/sitka
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3. Ctrl+A [select all fonts], Ctrl+C [copy] 
4. Navigate to Windows 10 Fonts folder (above) > Ctrl+V [paste] 
5. Back up this folder for potential use on Windows 11. 

Create a Repository for new Aktis-Sitka Fonts 
Aktis and Sitka have the same number of characters, which might prove useful; 
starting with A, Aktis will appear toward the top of the font list in Office, an 
advantage. 

6. Make an “Aktis-Sitka Fonts” folder, perhaps under \Source. 
7. Copy the four Sitka files from Windows 10 Fonts to Aktis-Sitka Fonts. 

Download and Install FontForge 
8. Download the FontForge installer7 and stash it safely, perhaps in 

\Source\FontForge. 
9. Right-click on the installer file > Run as Administrator > Yes. 

Make 24 New Aktis Fonts from Corresponding Sitka Fonts8 
10. Repeat these steps for each of the four TrueType font collections: 

a. Right-click on FontForge > Run as Administrator > Yes. 
b. In the app, click  > click the Aktis-Sitka Fonts location. (If it’s not there, 

navigate to “Aktis-Sitka Fonts” > click  > Bookmark Current Dir.) 
c. Select: (a) Sitka.ttc, (b) SitkaB.ttc, (c) SitkaI.ttc, (d) SitkaZ.ttc. 
d. Repeat these steps within each font collection for each of the six sizes: 

i. There are multiple fonts in this file, pick one: [1] Small, [2] Text, 
[3] Subheading, [4] Heading, [5] Display, [6] Banner; click OK. 

ii. Element > Font Info … 
iii. On the initial “PS Names” tab, change each occurrence of the five 

characters “Sitka” to the five characters “Aktis”. Preserve spaces 
and everything else as they were. 

 

 
7 https://fontforge.org/en-US/downloads/windows-dl/. (Instructions say to run as Administrator, so I do it.) 
8 https://themissy.com/2018/font-tutorial-renaming-font-files-for-duplicates-and-organization. 

https://fontforge.org/en-US/downloads/windows-dl/
https://themissy.com/2018/font-tutorial-renaming-font-files-for-duplicates-and-organization
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iv. Click the “TTF Names” tab. Aktis should already be here on the 
Family and Fullname lines. Change Sitka to Aktis on the UniqueID, 
Preferred Family and WWS Family lines.

 
(In theory, the four lines starting with Preferred Family can be 
deleted.) Don’t change any of the other mentions of Sitka. We are 
not trying to steal this font; we just want to make it work the way it 
was sold to us.  

v. Click OK. 
vi. Back on the main window, with its grid of fonts: File > Generate 

Fonts… > navigate to Aktis-Sitka Fonts (via pulldown, if necessary). 

  
vii. Select TrueType [if necessary; file becomes .ttf] > click Generate  

 
viii. Click Replace, if the prompt above appears. 
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ix. Click Yes, if the prompt above appears.

 
x. Click OK, if the prompt above appears. 

If desired, go back to step [v], change the specified Option, and 
repeat to here. I did not, at this time – seems fine. 

xi. Close FontForge, to close all open font files and prevent an accident. 

 
Click Don’t Save for the untitled file. 

e. … 5 more times around the steps above, starting with [i.] … 
11.  … 3 more times around the steps above, starting with [a.] … 
12. Start Font Forge > Navigate to Aktis-Sitka Fonts > check that you have 4 

each for 6 sizes of Aktis TrueType files (.ttf), 24 files total. 

Combine Six Aktis Fonts into Each of Four Collections9 
13. Repeat the following steps for each of the four TrueType font collections 

(regular, bold, italic and bold-italic): 
a. Start Font Forge > Navigate to Aktis-Sitka Fonts. 

b. Open each of the six fonts to be included in this collection: 
i. When the app starts, click on the Banner file.  

ii. Ctrl+click on the corresponding Display, Heading, Small, 
Subheading, and Text files.  

iii. File > Generate TTC  
iv. Change the .ttc name (AktisText below) to the corresponding name: 

Aktis.ttc, AktisB.ttc, AktisI.ttc, or AktisZ.ttc. (The last font selected is 
not listed with a check mark, but as the output file!) 
 
 

 
9 https://support.atlassian.com/confluence/kb/how-to-create-ttc-family-font-file/. 

https://support.atlassian.com/confluence/kb/how-to-create-ttc-family-font-file/


8 
 

 
v. There are lots of Options, none of which I used. Click Generate. 

vi. Close all six font windows. 
vii. Start the app and open the new .ttc file. Check that all six fonts are 

there, such as for Aktis.ttc: 

 
c. … 3 more times around the steps above, starting with [a.] … 

Install the Four TrueType Font Collections10 
14. In Windows itself, navigate to Aktis-Sitka Fonts. 
15. Select Aktis.ttc, AktisB.ttc, AktisI.ttc, and AktisZ.ttc. 
16. Right click on them > Install for all users. 

Change a Document to Use Aktis Fonts 
All pages in this article, except the page with the Sitka chart, must use Aktis 
fonts. First, change everything, and then bring in a fresh copy of the Sitka 
version of the chart. 

 
10 https://support.microsoft.com/en-us/office/add-a-font-b7c5f17c-4426-4b53-967f-455339c564c1 

https://support.microsoft.com/en-us/office/add-a-font-b7c5f17c-4426-4b53-967f-455339c564c1
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Change Existing Sitka Heading to Aktis Heading  
Repeat this step for each Aktis font (Small, Text, Subheading, Heading, Display, 
or Banner) used in the document. I have mostly Heading. 

Each document in Word may contain more than one “story.” Typical text and 
headings are one story. In this article, the footnotes form a second story. We 
could click inside one story, effect the change there, and then apply the same 
steps to the next story. It turns out we can do this more efficiently: 

1. Click within the normal text area. 
2. Home > Replace 
3. Assure that the “Find what” field is empty and selected. 

Format > Font > Sitka Heading > OK 
4. Click to select the “Replace with” field, and assure it is empty. 

Format > Font > Aktis Heading > OK 
Notice how the specified font is shown below each box: 

 
5. Click Replace All, and then, if asked, continue from the beginning. Repeat 

Replace All to process other stories, until Word reports 0 changes. 

Change Styles 
The changes above will do the job admirably, until we start updating the 
document. Even then, a new paragraph, for example, may inherit its style from 
the preceding, and be fine.  

However, if we have styles that we modified to specify Sitka fonts, applying 
those styles, such as clicking Normal or updating an Index, will do the wrong 
thing. We need to change those styles to use Aktis fonts. 
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Caution:  It is common to override the font within a styled area. To avoid 
changing such a desired font, do not apply any style revision to the 
document! (We should have already made all the changes we need.) 

 

In the Styles area of the ribbon, click the tiny arrow ( ) at the 
lower right, to bring up the Styles box.  

Do not click on any style here – it will change the document text.  

Instead, click the “A-check” box ( ), third from the left at the 
bottom, to bring up the Manage Styles box.  

(It would be OK to instead right-click on a style > Modify, thereby skipping the 
Manage Styles box.) 

 

The Normal style is already selected, and 
the Preview shows it uses the Sitka 
Heading font.  

Many other styles inherit their font from 
Normal, so this is the most important to 
change. 

Click Modify… 

In the Modify Style box, click Sitka 
Heading and select Aktis Heading. 

Now is a good time to fix any other 
issues that will be useful. The default 
space after a paragraph is 10 points – 
OK here, but in the book, I’ll use 
Format > Paragraph to specify 6. 

Click OK when done with changes. 

Back at Manage Styles, click Heading 
1, and if a Sitka font is specified, 
change it in the same manner.  
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If Sitka is inherited, in the Modify box, the font will be blank. Do nothing and 
click Cancel. 

Proceed down the whole list in this manner. 

Note that, as specified, these changes apply only to the current document. 

In this article, I needed to change: Normal, Heading 1-6, Title, Quote, Intense 
Quote, List Paragraph, Caption, Bibliography, TOC1-9, Body Text (+2-3), Body 
Text First Indent (+2), Body Text Indent (+2-3), Closing. Also on the Set 
Defaults tab, I selected Aktisis Heading. This mess grew over time. I need to fix 
or replace my model files for new articles and books. 

Testing the Font Families 
Most of the text in this article is at 14 points, with footnotes at 10 points. The 
charts on the following pages use the point sizes listed. 

To test, I printed the charts for both Sitka and Aktis from the Windows 10 PDF, 
each on its own sheet. When I put them together and held them up to the light, 
they were identical, except for the names of the font families. 

Years after I took the listed measurements, current measurements differ. The 
differences don’t change my conclusions. The heights of all the Aktis and Sitka 
boxes is now consistent at 0.75 inch with my current system, software 
configuration, and printer. 

 

 

26 Aug 2025: I upgraded my system to Windows 11, and then exported this file 
again (with this update). The Sitka chart is inferior in the PDF only, the 
Windows 11 export bug. As my system is configured, fonts that cannot be 
exported are bitmapped. In the PDF, the bold font names in the Sitka chart are 
no longer bold. If you look carefully, you will see that the bitmapped fonts in the 
six Sitka boxes are inferior to the quality of the Aktis fonts – which perpetuate 
the original quality of Sitka. 

If you are one of the few people in the world who still cares about this issue, I 
would be pleased if you drop me a line (the link to my address is my name, 
below the title). 
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Aktis Font Comparison at 11 pt 
Aktis Small (for 0-9.5 pt)  0123456789 

The quick brown fox jumps over the lazy dog. 
The QuIcK bRoWn FoX jUmPs OvEr ThE lAzY dOg. 
tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG. 

3.50” W 
0.77” H 

Aktis Text (for 9.5-13.5 pt)  0123456789 
The quick brown fox jumps over the lazy dog. 
The QuIcK bRoWn FoX jUmPs OvEr ThE lAzY dOg. 
tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG. 

3.25” W 
0.77” H 

Aktis Subheading (for 13.5-18.5 pt)  0123456789 
The quick brown fox jumps over the lazy dog. 
The QuIcK bRoWn FoX jUmPs OvEr ThE lAzY dOg. 
tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG. 

3.03” W 
0.77” H 

Aktis Heading (for 18.5-23.5 pt)  0123456789 
The quick brown fox jumps over the lazy dog. 
The QuIcK bRoWn FoX jUmPs OvEr ThE lAzY dOg. 
tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG. 

2.88” W 
0.77” H 

Aktis Display (for 23.5-27.5 pt)  0123456789 
The quick brown fox jumps over the lazy dog. 
The QuIcK bRoWn FoX jUmPs OvEr ThE lAzY dOg. 

tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG. 

2.72” W 
0.77” H 

Aktis Banner (for 27.5-∞)  0123456789 

The quick brown fox jumps over the lazy dog. 

The QuIcK bRoWn FoX jUmPs OvEr ThE lAzY dOg. 
tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG. 

2.62” W 

0.77” H 

Times New Roman (11.5 pt, for comparison)  0123456789 

The quick brown fox jumps over the lazy dog. 

The QuIcK bRoWn FoX jUmPs OvEr ThE lAzY dOg. 

tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG. 

2.92” W 
0.73” H 

Calibri (11.5 pt, for comparison)  0123456789 
The quick brown fox jumps over the lazy dog. 
The QuIcK bRoWn FoX jUmPs OvEr ThE lAzY dOg. 
tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG. 

2.91” W 

0.79” H 

 
W:  The width of “The quick brown fox jumps over the lazy dog.” 

H:  The height of the current row, line to line. 
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Sitka Font Comparison at 11 pt 
Sitka Small (for 0-9.5 pt)  0123456789 

The quick brown fox jumps over the lazy dog. 
The QuIcK bRoWn FoX jUmPs OvEr ThE lAzY dOg. 
tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG. 

3.50” W 
0.77” H 

Sitka Text (for 9.5-13.5 pt)  0123456789 
The quick brown fox jumps over the lazy dog. 
The QuIcK bRoWn FoX jUmPs OvEr ThE lAzY dOg. 
tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG. 

3.25” W 
0.77” H 

Sitka Subheading (for 13.5-18.5 pt)  0123456789 
The quick brown fox jumps over the lazy dog. 
The QuIcK bRoWn FoX jUmPs OvEr ThE lAzY dOg. 
tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG. 

3.03” W 
0.77” H 

Sitka Heading (for 18.5-23.5 pt)  0123456789 
The quick brown fox jumps over the lazy dog. 
The QuIcK bRoWn FoX jUmPs OvEr ThE lAzY dOg. 
tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG. 

2.88” W 
0.77” H 

Sitka Display (for 23.5-27.5 pt)  0123456789 
The quick brown fox jumps over the lazy dog. 
The QuIcK bRoWn FoX jUmPs OvEr ThE lAzY dOg. 

tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG. 

2.72” W 
0.77” H 

Sitka Banner (for 27.5-∞)  0123456789 

The quick brown fox jumps over the lazy dog. 

The QuIcK bRoWn FoX jUmPs OvEr ThE lAzY dOg. 
tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG. 

2.62” W 

0.77” H 

Times New Roman (11.5 pt, for comparison)  0123456789 

The quick brown fox jumps over the lazy dog. 

The QuIcK bRoWn FoX jUmPs OvEr ThE lAzY dOg. 

tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG. 

2.92” W 
0.73” H 

Calibri (11.5 pt, for comparison)  0123456789 
The quick brown fox jumps over the lazy dog. 
The QuIcK bRoWn FoX jUmPs OvEr ThE lAzY dOg. 
tHe qUiCk BrOWn fOx JuMpS oVeR tHe LaZy DoG. 

2.91” W 

0.79” H 

 
W:  The width of “The quick brown fox jumps over the lazy dog.” 
H:  The height of the current row, line to line. 

 


